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Introduction

Kroy Limited Warranty
Kroy LLC (“Kroy”) warrants its labeling system equipment against defects in material and work-
manship for a period of six (6) months from the date of purchase. At no charge to the customer
except for inbound freight to Kroy’s service center, Kroy will, at Kroy’s option, repair or replace
any product determined to be defective. Kroy will pay return UPS ground charges. A purchase
receipt or other evidence of purchase will be required before warranty service is rendered. This
warranty does not cover cosmetic damage or any damage caused by accident, misuse, abuse,
negligence or modification or attempted repair by anyone other than Kroy or a Kroy authorized
repair agent. THERE ARE NO EXPRESS WARRANTIES EXCEPT AS SET FORTH IN THIS
PARAGRAPH.

KROY SHALL NOT BE LIABLE FOR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES
FOR BREACH OF ANY EXPRESS OR IMPLIED WARRANTY ON THIS PRODUCT. ALL
EXPRESS AND IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILI-
TY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED TO THE APPLICABLE
WARRANTY PERIOD SET FORTH ABOVE.

Some states do no allow the exclusion or limitation of incidental or consequential damages, or
limitations on how long an implied warranty lasts, so the above exclusions or limitations may
not apply to you. This warranty gives you specific legal rights, and you may have other rights
which vary from state to state.

If a problem develops with your Kroy labeling system during or after this warranty period, you
may contact Kroy customer service at 800.729.5769.

FCC Notice
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful inter-
ference when the equipment is operated in a commercial environment. This equipment generates, uses and
can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be required to correct the interference at his
own expense.

Any changes or modifications not expressly approved by the manufacturer could void the user’s authority to

operate the equipment.

CDC Notice
This digital apparatus does not exceed Class A limits for radio noise for digital devices as set out in the radio
interference regulations of the Canadian Department of Communications.

Battery and AC Adapter Notice
This product is intended to be supplied by a Listed Power Unit AC adapter rated 12V DC, minimum 4.0A. 

CAUTION: (for Lithium Battery) Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the manufacturer’s instructions.

CAUTION: (for rechargeable Ni-Cd Batteries) Risk of explosion if batteries are replaced by an incorrect type.
Replace only with C size Ni-Cd batteries rated 1.2V maximum 2500 mAH. DO NOT USE ALKALINE
BATTERIES IN THIS PRODUCT.

The K5100 Printer and Cartridges are protected by U.S. Patents including: 5,411,339  5,533,818



Kroy - Caring for the Environment

Product Disposal Instructions
The symbol shown here and on the product means that the product is 
classed as Electrical or Electronic Equipment and should not be disposed 
of with other household or commercial waste at the end of its working life.

The Waste of Electrical & Electronic Equipment (WEEE) Directive 
(2002/96/EC) has been put in to effect to recycle products using the best 
available recovery and recycling processes to minimise the impact on the 
environment, treat any hazardous substances and avoid increasing landfill.

Product Disposal Instructions for domestic / home users
When you have no further use for the product, please remove any batteries and dispose
of them and the product as per your local authority's recycling processes. For more 
information please contact your local authority or the distributor / retailer from where the
product was purchased.

Product Disposal Instructions for business / commercial users
Business users should ensure that this product is not mixed with other commercial waste
for disposal. Please contact the distributor from where the product was purchased to
check the terms of your purchase contract. 

Alternatively please contact Kroy Europe Ltd:
Tel: +44 (0)118 986 5200
Fax: +44 (0)118 986 5205
Email: info@kroyeurope.com

Kroy Europe Ltd  WEEE Producer No.: WEE/KA0053TQ
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Contents of Box

3

(1) K5100 Handheld Label Printer (1) Owner’s Manual and (1) CD-ROM
with KLDS Software and Drivers

(1) AC Adapter with Power Cord (1) Serial Cable
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Tape Compartment

LCD Display

Cutter

Print Key

Cursor Keys

Delete/Esc Key

Function Keys

Enter Key

Figure 1: Top View of Printer

Figure 2: Left Side of Printer

Power Switch

Serial Port

AC Adapter Jack

LCD Contrast
Adjustment



Important Safety Precautions
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When using your printer, always follow these important safety
precautions:

1. Read all instructions carefully.
2. Do not immerse the printer in water or other liquids, you could receive an 

electrical shock.
3. Do not apply adhesive labels to your skin.
4. Do not put objects onto or into the printer.
5. Do not expose to high temperatures or high humidity. Never leave on the 

dashboard or in the trunk of your car.
6. Do not use in dusty places and avoid direct exposure to sunlight and rain.
7. Do not pull on the tape, you could damage the tape cartridge.
8. Do not attempt internal repairs to the printer. If service or repair is needed, 

contact a qualified Kroy service representative.
9. Do not touch the printhead ceramic or rollers with your fingers.



Connecting AC Adapter
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The supplied AC adapter can be used to power the K5100. Warning: Only use
the AC adapter provided with this machine. Use of any other AC adapter
may damage your K5100 and void the warranty.

Connecting the AC Adapter 
1. Insert the AC adapter plug into the AC adapter jack on the left side of the 

machine.
2. Plug the other end of the AC adapter into the nearest standard electrical  

outlet.

Figure 3: AC Adapter Connection

WARNING: K2500, K3000-PC and K240 AC adapters are NOT compatible
with the K5100.

AC Adapter Jack

AC Adapter Plug
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Installing Batteries (Optional)

+ -
+-

+ -
+ -

+ -
+-

Installing Batteries (Optional)
Your K5100 printer can optionally operate with six 2.5 Ampere-hour “C” size
nickel cadmium batteries for primary power. Do not replace with other type
batteries. These batteries can be purchased from Kroy or your Kroy 
dealer as accessory Part# 2449300 (6 pack Ni-Cd battery).

WARNING: Do not dispose of batteries in fire, mutilate,short-circuit, mix with
other battery types. Batteries may explode, release toxic material, or get hot
and cause personal injury.

Removing the Yellow Elastomer Jacket
1. Pull the jacket down from the top of the printer until clear of the top 

portion of the printer.
2. While holding the printer from the bottom, grab the top portion of 

the printer and lift it out of the jacket.
3. To replace the jacket reverse steps 1 and 2.

Note: The jacket must be removed to install batteries.

Installing the Nickel-Cadmium Batteries
1. Remove the battery cover by pushing down on the arrow and sliding it off 

the base in the direction of the arrow.

2. Insert the batteries according to diagram imprinted on the printer case 
under the batteries.

3. Replace battery cover.

Nickel-Cadmium
Batteries

Backup Battery
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Charging Batteries 

Charging Main Batteries
The internal Ni-Cd battery charger operates when the AC adapter is connected
to the K5100 printer. The normal complete charge cycle for fully discharged bat-
teries is approximately 8 hours. There are two versions of the K5100 with slight-
ly different internal battery chargers. Both perform the same functions, but the
indicator LED’s are different.

On version “A” printers, the left and right LED’s are green and the center LED is amber.

On version “B” printers, the left LED is amber and the center and right LED’s are green.

If the battery charger indicates an error, the AC adapter should be removed and
reconnected. If the second charge cycle also indicates an error, the batteries
should be replaced. 

For batteries that are deeply discharged it may take as much as 2 hours for any
LED indicators to illuminate and it may take two charge cycles to fully charge.

The three LED’s at the front of the printer indicate the internal battery charger
status as shown below:

Charge Phase Left LED (Green) Middle LED (Amber) Right LED (Green)

No Ni-Cd Battery
Detected

Battery Detected

Soft Start Charge

Charging

Topping Charge

Charge Complete

Error

Off Off Off

Fast Flash Off Off

Slow Flash Off Off

On Slow Flash Off

On Fast Flash Off

On Off On

Fast Flash Off Fast Flash

Version “A” 
When the two green LED’s are ON, the charge cycle is complete and the AC adapter can be removed.

Charge Phase Left LED (Amber) Middle LED (Green) Right LED (Green)

No Ni-Cd Battery
Detected

Battery Detected

Charging

Charge Complete

Error

Off Off Off

Off Off On

Off On On

Off Off On

On Off Off

Version “B”
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Installing the Supply Cartridge

Figure 4: Installing the Supply Cartridge

Lock/Release 
Knob

Supply Cartridge

Exit Slot

Printhead
& Rollers

1. Wind the ribbon spool on the bottom of the supply cartridge counter-clock
wise two full turns in the direction of the arrow with your finger.

2. Insert cartridge into the cartridge cavity with the lock/release knob 
turned counter-clockwise and the excess material threaded in the exit slot.

3. Turn the lock/release knob clockwise to lock the cartridge into place.
4. Press FEED and you are ready to create a label.



Chapter 2
Printing Your First 

Label



Printing a Label
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Kroy 5100 _ 1:_
2:

Cable 2E45 

1: Cable 2E45_  
2:

Turning the Printer On
Use the Power switch located on the left side of the printer to turn the printer
on. The following displays will appear:

Cursor Movement
The underline seen above is the cursor. The cursor shows you the current 
typing position. Cursor keys move the cursor through text without changing it
and through options without selecting any. The left and right cursor keys move
left and right, one option or one character at a time; the up and down cursor
keys move the cursor up and down through lines of text, one line at a time. 

Adjusting LCD Contrast
The LCD Contrast allows you to lighten or darken the LCD of your printer. To
darken the screen, turn the LCD contrast control clockwise. To lighten the
screen, turn the LCD contrast control counter-clockwise.

Default Printer Settings
When the power is turned on for the first time, there are pre-programmed 
printer settings. One of these is the Auto Size feature. This feature auto sizes
the text of your label to the current cartridge supply and size of media. You can
find this function by pressing the Size key. You can always turn auto sizing off
and type in a designated size, but for our example we will have auto sizing ON.
The default font is “Block”. No other font is installed on your K5100, however,
other fonts of your choice can be downloaded into your K5100. The default 
justification is left. For more information on formatting and label setup see
Chapter 3.

In the following examples, we have kept the default settings ON. 

Type in the text “Cable 2E45” 

Now that your label is typed, you will press the Print Key and the auto sizing
feature automatically sizes the text for the cartridge you are using. 



1: Cable 2F45
2: Floor 2C 

Style Menu

_ Rotate  _Bold  _Italic       *

To make a two line label, press Enter at the end of line 1 and you will see the
cursor go to line 2. Type in the text “Floor 2C” on line 2.

Now that you have two lines typed, press the Print key and the auto sizing
feature automatically sizes the two lines for you. 

To add additional lines, perform the same function again.

Editing Text
You can correct or change characters by using the left and right cursor keys to
move the cursor to the right of the character to be changed. Use the Delete key
to delete the character and type in the correction. Below we changed the “E” on
line 1 to “F” in our example.

Move the cursor to the right of “E” on line 1, press the Delete key and type in
the letter “F”.

Adding a Character Style
You can change the style of text previously entered by using the left and right
cursor keys to position the cursor to the beginning of your text. Press the Style
key to select your character style of choice. To turn styles on and off use your
Enter key. 

In the following example, the cursor is moved to the beginning of the word
“Floor” and Bold was then selected in the Style Menu. Note: Only text to the
right of the cursor will be changed.

Now that your label has been edited and styled press the Print Key.

Cable 2E45 
Floor 2C

1: Cable 2E45  
2: Floor 2C_

1: Cable 2E45_  
2:

1: Cable 2E45  
2: Floor 2C

1: Cable 2F45  
2: Floor 2C

Cable 2F45 
Floor 2C

12



1: File Server_  
2:
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Printing on Shrink Tube

Kroy offers flattened shrink tube cartridges for wire marking. Insert a shrink tube
cartridge for this example.

You will start with a New file. To create a New file, press the File
key and select New with the Enter key. Or use Shift and File as a shortcut. 

For our example, we kept Auto Size ON.

Type in the following text “File Server”

Press the Print key. Cut the shrink tube label and insert the wire.

The tubing can be shrunk around the wire with a heat gun.

For further information on formatting the text of your shrink tube See Chapter 3.

File Server



Kroy offers self-laminating wire wrap cartridges ideal for marking terminated
wires and cables. Insert a self-laminating wire wrap cartridge for this example.

For our example, we kept Auto Size ON.

You will start with a New file. To create a New file, press the File key and select
New with the Enter key. Or use Shift and File as a shortcut. When using a wire
wrap cartridge, this will activate the automatic rotation feature. Rotation is nec-
essary because the printable area of a wire wrap is vertical and represents a
small portion of the label.

Type in the following text “300E”

Press the Print key then Feed and you have a wire wrap ready to apply.

Apply the printed portion of the label to your wire and wrap the laminated tail
around the wire.

For further information on formatting the text of your wire wrap See Chapter 3.

14

Printing a Self-Laminating Wire Wrap
30

0E

1: 300E_  
2:
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Frequently Used Keys

The keyboard is used to enter label text and access menus. You will hear an
audible click whenever a key is depressed. The frequently used keys on the
keyboard are described below.

Function keys (File, Font, Size, Style, Repeat), will automatically prompt a list
of selections to choose from. When using some function keys, the printer will
display submenus or prompt you for information. These function keys also act
as “toggles” which allow you to turn an option on or off. 

The Alt Key accesses special character symbols shown in blue on particular
keys. To enter a special character, (such as Å), hold down ALT and press the
key of choice at the same time. To abort a print job, use the Alt and the Print
keys together.

The Cursor (Arrow) Keys move the cursor through text without changing it and
through options without selecting any. The left and right Cursor keys move left
and right, one option or one character at a time; the up and down Cursor keys
move up and down through lines of text, one line at a time. When used with
SHIFT, the up and down Cursor keys act as Page up (previous label) and
Page Down (next label) keys and the left and right Cursor keys move the cur-
sor one word at a time.

The Caps Key locks capital letters on. Pressing the Caps key again turns off
the function. The Caps key does not effect the number keys. 

The Delete Key allows you to cancel functions or escape from menus. Delete
erases characters to the left of the cursor.  To Delete an entire line, hold down
Alt and the Delete key together.

The Enter Key in typing mode, moves the text or the cursor to the next line. In
function mode, the Enter key selects specific menu options, file names and
default printer settings.

The Feed Key advances the tape from the printer.

The Print Key prints the current label and advances the tape far enough to
clear the cut mechanism. 

The Shift Key capitalizes individual letters and accesses the black characters
on the number keys (such as !). Using the Shift and File key creates it clears
text allowing you to create a new label.



Chapter 3
Operating Your

Printer
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Font Function

Using the Font Menu
When you select the Font key the printer displays the default “Block” font seen
below. This is the only font included with the K5100.

K5100 has the option of downloading fonts from your PC. When you download
a font, it will be added to your Font menu.

Press Enter to accept the current Block font or use the left and right cursor keys
to move the cursor to the left of the font you want and press Enter to select it.

See Downloading Fonts on Pages 43-44 for further information. 

 _ Block
Font Menu

 _ Block _times _arial
Font Menu
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Size Function

Using the Size Menu
Select Size to specify the print size for your text. The printer displays the default
Auto Size function and waits for your entry. Press Delete to accept auto sizing
or type a different size and press Enter. Valid sizes of 4-72 pt can be entered.

Size Menu
_ 24            _Auto       Size *

Auto Size OFF

When printing, the K5100 will show what point size is being printed in the auto
size mode. See below.

If you select Auto Size, the K5100 will automatically adjust the print size based
on the number of lines of your label and the width of the label media. If you turn
auto size off, the size of the print you select must take into account the number
of lines of your label and the width of the media.

If auto size calculates a point size smaller
than 4 point, an error message will be 
displayed.

If the text you have typed is too large, an
error message will be displayed. 

See the table below which can be used as a guide. The table assumes using
characters of all the same size (capital letters). When using characters of vary-
ing size (such as lower case letters or accent characters) or using character
styles (such as bold, italic etc.) the maximum point sizes will vary slightly.

Tape Size     1 Line      2 Line      3 Line      4 Line       5 Line      6 Line

0.50”         38 pt 19 pt 12 pt 8 pt           N/A N/A

0.80”          60 pt 30 pt 20 pt        15 pt          11 pt          N/A

1”            72 pt 36 pt 24 pt        18 pt         14 pt         12 pt

Error
FontSize Too Big 

Printing.....
Auto Size xx pt

0.375”        28 pt 11 pt 8 pt N/A N/A N/A

Error
Size Too Small 
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Character Styles

This section explains how to use the Style key to assign text formatting attrib-
utes to your label text. There are three types of text attributes: character, line
and page. These attributes, as well as their defaults and options, are shown in
the following table.

Attribute

Font

Size   

Justification 

*Bold

*Italic

*Mirror

*Vertical

*Frame

*Underline

Rotate

Defaults   Options   

Block
Download True Type
Fonts from PC

Auto Size On
.50”  4-30 point size
.80”  4-55 point size

1”  4-72 point size

Left Left, Center, Right

Off On, Off

Off On, Off

Off On, Off

Off On, Off

Off

Off

Page: On, Off

Line: On, Off

Off On, Off

On, OffOff

* Attributes marked with a asterisk are toggles.   are line attributes. They affect
the entire line of text that the cursor is positioned on.    are page attributes.
They affect the entire page (label). All other attributes (except Frame) are char-
acter attributes only and affect the text from the point that the cursor is posi-
tioned.

The following style settings are available on the K5100: Rotate, Bold, Italic, 
Underline, Justify, Mirror, Frame and Vertical.

To Select Multiple Styles, with less keystrokes, use the Space key and the
cursor keys to turn styles on and off. For more Shortcuts, See page 24.

Note: When the Style menu is selected, all selections are not visible on the
LCD display - you will have to use your left and right cursor keys to scroll
through all the choices.



The most common character styles used are Bold, Italic and Underline.

To emphasize the text of your label using Bold, move the cursor to the position
where you want to apply the Bold attribute and press the Style key. Use the left
and right cursor keys to move the cursor to the left of Bold and press Enter.
When turned on, an asterisk will appear. To turn Bold off, press Enter again or
to exit press Delete.

Bold Example:

To italicize the text of your label using Italic, move the cursor to the position
where you want to apply the Italic attribute and press the Style key. Use the left
and right cursor keys to move the cursor to the left of Italic and press Enter.
When turned on, an asterisk will appear. To turn Italic off, press Enter again or
to exit press Delete.

Italic Example:.

To underline the text of your label using Underline, move the cursor to the posi-
tion where you want to apply the Underline attribute and press the Style key.
Use the left and right cursor keys to move the cursor to the left of Underline
and press Enter. When turned on, an asterisk will appear. To turn Underline
off, press Enter again or to exit press Delete.

Underline Example:

20

Style Menu

_ Underline  _Justify       *
1: ATTENTION  
2:

Style Menu

_ Rotate  _Bold  _Italic       *
1: ATTENTION  
2:

Style Menu

_ Rotate  _Bold  _Italic       *
1: ATTENTION  
2:

ATTENTION

ATTENTION

ATTENTION
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Other Styles

Other character styles include Mirror, Frame, Justify, Vertical and Rotate.

To reverse the text of your label using Mirror press the Style key. Use the left
and right cursor keys to move the cursor to the left of Mirror and press Enter.
When turned on, an asterisk will appear. To turn Mirror off press Enter again or
to exit press Delete. When using mirror image, use clear tape for best results.

Mirror Example:

To draw a box around the text of your label using Frame press the Style key.
Use the left and right cursor keys to move the cursor to the left of Frame and
press Enter. When turned on, an asterisk will appear. The printer displays the
frame menu and waits for you to select the type of frame you want. To turn
Frame off, press Enter again or to exit press Delete.

Once Frame is selected, the Frame Menu will appear. To frame all the text on
the label, select Page by pressing the Enter key. When turned on, an asterisk
will appear

Page Frame Example:

ATTENTION

Frame Menu
_ Page  _Line       *

ATTENTION 
EMPLOYEES

1: ATTENTION
2: EMPLOYEES 

Style Menu

_ Mirror  _Frame       *

Style Menu

_ Mirror  _Frame       *
1: ATTENTION  
2:
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To frame just a line of text, move the cursor to the line of your text and select
Line by pressing the Enter key. When turned on, an asterisk will appear

Line Frame Example:

To justify the text of your label using Justify press the Style key. Use the left
and right cursor keys to move the cursor to the left of Justify and press Enter.
The printer displays the justify menu and waits for you to select the justification
of your choice. To exit the Justify menu press Enter or the Delete key. Note:
The default justification is left.

Left Justification

Center Justification

Right Justification

Justify Menu
_ Left _Center _Right       *

1: ATTENTION
2: PLEASE 

ATTENTION 
PLEASE

ATTENTION 
PLEASE

ATTENTION 
PLEASE

1: ATTENTION
2: EMPLOYEES 

Frame Menu
_ Page  _Line       *

ATTENTION 
EMPLOYEES
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To print the text of your label vertically instead of horizontally using Vertical, 
press the Style key. Use the left and right cursor keys to move the cursor to the
left of Vertical and press Enter. When turned on, an asterisk will appear. To
turn Vertical off press Enter again or to exit press Delete. 

Vertical Example:

To rotate the text of your label using Rotate, press the Style key. Use the left
and right cursor keys to move the cursor to the left of Rotate and press Enter.
When turned on, an asterisk will appear.To turn Rotate off, press Enter again or
to exit press Delete. 

Rotation and Vertical are not the same. Note: Mirror is ignored when rotation is
selected.

Rotate Example:

Auto Rotation
When a self-laminating wire wrap cartridge is installed, the K5100 will automati-
cally rotate and auto size the text using the instructions below.

You will start with a New file. To create a New file, press the File key and select
New with the Enter key. Or use Shift and File as a shortcut. This will activate
the auto rotation feature. 

Style Menu

_ Rotate  _Bold         *
1: 300E_  
2:

30
0E

Style Menu

_ Vertical  _Rotate         *
1: ATTENTION  
2:

A T T E N T I O N



Label Setup
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To select the Label Setup press the Shift and the Style key together. The
prompt below will appear. The menu options are length, cutmark, left margin
and vertical margin.

In the default setting, the Length of a printed label automatically adjusts to fit
the length of text. If you want to specify the length of a label, the Length func-
tion allows you to set the length between 0.3” and 20”. To turn Auto off, type in
your specific length and press Enter. To exit the length menu without making
any changes press Delete. 

The Cutmark function creates cutmarks along a print job. Use the left and right
cursor keys to move the cursor to the left of Cutmark and press Enter. When
turned on, an asterisk will appear. To turn Cutmark off press Enter again or to
exit the menu without making any changes press Delete. 

The Left margin function allows you to increase the size of your left margin by
moving text from the left to the right of your label. The amount is measured in
pixels. Use the left and right cursor keys to move the cursor to the left of
Leftmargin and press Enter. A prompt will appear. Use the right and left cursor
keys to select an increment up to 30 pixels. Press Enter to select the increment
of choice. See the example below.

This function is used with die cut labels and self-laminating wire wraps only.

The text seen here 
has printed right
to the edge.

The text is now adjusted.

Label Setup
_ Length _Cutmark        

Length Menu
 Len_ 0.3     Auto      *

Label Setup
_ Length _Cutmark        *

Room 5 Room 6
Floor 2C Floor 2C

Left Margin 
 Margin:  _ +5      

C
ab

le
 3

E
S
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ve

r
C
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 3
E
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The Vertical margin function allows you to move text from the top to the bottom
by pixel on your label. Use the left and right cursor keys to move the cursor to
the left of Vertmargin and press Enter. A prompt will appear below. Use the
right and left cursor key to select an increment up to 30 pixels. Press Enter to
select the increment of choice. See the example below.

The text seen here has printed to
the bottom of the label.

The text is now adjusted upward on the label.

Vert Margin 
 Margin:  _ +2      

ATTENTION 
EMPLOYEES

ATTENTION 
EMPLOYEES



Shortcuts and Hot Keys
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A Shortcut will provide a direct route to some submenus and options. See the
listing below. To use a shortcut, first press and hold the Shift or Alt key and
then press the second key.

Shift + File Creates a New File / Erases All Text
Shift + Font Bar Code Menu
Shift + Size Toggle Auto Size On/Off 
Shift + Style Label Setup
Alt + Style All Styles Reset
Shift + Repeat Time/Date Menu
Shift + Delete Printer Setup
Alt + Print Stops Print Job
Alt + Delete Erase Current Line

The Space key can be used to select multiple items on a menu. For example, in
the Style Menu, if you want Bold and Italic on at the same time simply use
your cursor key and the Space key to select these options and then exit the
menu using the Delete key.

Hot keys are represented by a capitalized letter in most function key menus (i.e.
_New _Open _Save). For example, the File Menu is selected. By pressing the
letter “N”, a new file will be selected without using the cursor keys and the enter
key. Hot keys turn menu options on and off. And they also act as a shortcut to
submenus. Note: The function key must be selected first before using the hot
key. Hot keys work only in function mode.

Below is a listing of some of the function menu’s hot keys.

File Menu Hot Keys
“N” New File    
“O” Open File Menu
“S” Save File Menu

Size Menu Hot Keys
“A” Auto Size On/Off

Style Menu Hot Keys
“R” Rotate On/Off
“B” Bold On/Off
“I” Italic On/Off
“U” Underline On/Off

“J” Justify Menu
“L” Left Justify On/Off 
“C” Center Justify On/Off
“R” Right Justify On/Off
“M” Mirror On/Off
“F” Frame On/Off
“V” Vertical On/Off

Repeat Menu Hot Keys
“S” Sequence Menu
“I” Insert
“A” Alpha On/Off - Sequence Start/End
“N” Numeric On/Off - Sequence Start/End
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This section explains how to use the Repeat key to print multiple copies
of a file or sequence text either numerically or alphabetically.

Press the Repeat key to make copies or sequence labels. The prompt below
will appear. 

Select Copies to specify the number of copies you want to print (1-999). Use
the left and right cursor keys to move the cursor to the left of Copies and press
Enter. The printer displays the current setting for this option (see the following
example) and waits for your entry. Press Delete to accept the number of copies
shown, or type in your specific number and press Enter. Press Print.

Select Sequence to automatically generate and print labels containing a
sequence of one letter or one to three numbers (101 102 103, ABC....etc.) with-
out having to type the text of each label yourself. You simply tell the printer what
characters to print on the first and last labels an how much to increment
between labels (see following table).

The sequence character takes on the current character attributes previously
defined. Optionally, you can redefine the sequence character’s attributes like
any other character. Note: You can only define one sequence type (numeric or
alpha) per document/file, but you can place the sequence character in your 
document/file once on each line.

Repeat Menu
_ Sequence  _Copies       

Copies Menu
 Copies:  _ 3      

Start Stop       Increment       Individual Labels Printed  

1 10 1 1 2 3 4 5 6 7 8 9 10   

2 12 2 2 4 6 8 10 12   

A J 1 A B C D E F G H I J 

a z 4 a e i m q u y  

Printing Sequential Labels
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Select Sequence from the menu. The sequence menu will appear.

Use the left and right cursor keys to move to the left of the option you want and
press Enter to select it.

If you choose Alphabetic, the printer prompts you to enter the first letter you
want printed (if you choose Numeric, this prompt reads Start #, you will then  
need to enter the beginning number). Type the letter or number you want print-
ed first and press Enter.

If you choose Alphabetic, the printer next prompts you to enter the last letter
you want printed (if you choose Numeric, this prompt will read End #):Type the
last letter or number you want printed in the sequence and press Enter. 

The printer next prompts you to enter the increment amount. Press Enter.

Next, the sequence menu will appear select Insert by pressing Enter. This will
place the sequence character where you have the cursor next to your text. A
black box will be seen where the sequence will begin. See example below.

For our example, we have the Cutmark On (See page 22) and have selected 2
Copies (see page 25).

Sequence Menu
_ Insert  _Alpha  _Num       *

Sequence Start
 Start:  _ A      

Sequence End
 End:  _ C      

Sequence Inc
 Inc:  _ 1      

1: L1  _  
2:

L1A L1A L1B L1B  L1C  L1C
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To select the Printer Setup press the Shift and the Print key together. The
prompt below will appear. The menu options are reset, unit of measure, density,
auto off, advance cut, language, printspeed and lcd contrast.

Select Reset to restore all factory settings and defaults. To select Reset press
Enter or to exit press Delete.

The Unit of Measure function allows you to choose the unit of measure you
want to use for setting label width and margin. The options are tenths of an inch
(default) and millimeters. Select Unit from the printer setup menu by using the
cursor keys and pressing Enter. The unit menu will appear. Use the arrow keys
to move to the left of the option you want and press Enter.To accept the current
setting press Delete.

Select Density to specify the density (0-7) for printing the current label. Density
will make the label darker or lighter per unit measure. The printer displays the
current density setting and waits for your entry. Press Delete to accept the
value shown, or use the left cursor key to add density and press Enter. 

If the characters are smeared on a label or are not completely filled in, you can
attempt to fix the problem by adjusting the print density. If the characters are 
smeared, specify a lower number in the field; if the characters are not complete-
ly filled in, specify a higher number. You may need to adjust the density after 
installing a new tape.

Printer Setup
_ Reset _Unit _Density 

1:_
2:

Unit Menu
_   Inch  _MM       *

Density Menu
 D:  #### _      



30

Select Auto Off to activate auto shut off. The factory default is to shut off the
printer after 5 minutes of non-use. When the printer is turned off, all current
label text and text attributes settings are saved. All files in memory are still
saved. Press Delete if you decide you do not wish to change the current set-
ting. Or press Enter to activate auto shut off. When turned on, an asterisk will
appear. By default, this function is on.

The Advance to Cut function advances the label material to the cut position.
The default setting is advance to cut enabled. If you do not need this function
you may disable the advance to cut function by using the cursor keys to move
to the left of Advance in the printer setup menu and press Enter. 

The Language function allows you to choose from 4 different languages. The
default language is English. Other options are spanish, french and german.
Select Language from the printer setup menu by using the cursor keys and
press Enter. The language menu will appear. Use the cursor keys to move to
the left of the language you want and press Enter. To accept the current setting
press Delete.

Printspeed is the rate at which the label advances from the printer when print-
ed.The default printspeed is unlimited. To specify a printspeed, select PrtSpeed
from the printer setup menu by using your cursor keys and press Enter. The
printspeed menu will appear and by using your cursor keys you can select from
the options below by pressing Enter. To accept the current setting press Delete.

Languages Menu
_ English _eSpanoL _Francai _Deutsch   *

PrtSpeed Menu
_ Unlimit _0.5 _0.8 _1.0       *
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To print a Bar Code, press the Shift and the Font key together. Use the Bar
Code Menu to specify the type of bar code you want to print.

K5100 has ten bar codes built-in. The following table summarizes information
on these bar codes.The 

After the bar code selection has been made, press the Shift and Font keys
together to go back to the Bar Code menu. The menu will change allowing you
to customize the bar code selected using code, text and resolution.

Codabar

Code 39

EAN-8

EAN-13

Interleaved
2 of 5

UPC-A

UPC-E

Code 128

MSI Plessey

PDF 417

Valid 
Characters   

Checksum
Options 

Available   

Fixed
Length

Bar Code
Type

Special Restrictions
& Other Information

First and last characters
must always be either A,
B, C, or D. Letters not allowed 
in body of bar code

< 32 
characters

0 -9   A - D
. - $ / + %

None, mod 10,
mod 16

0 -9   A - Z
. - $ / + %
space

None, mod 43
< 32 
characters

Lowercase letters not allowed

0 -9   EAN-8
7, 9 or 12
digits

Length varies because of  
optional 2 or 5 digit supplemental

0 -9   EAN-13 12, 14 or 17
digits

Length varies because of  
optional 2 or 5 digit supplemental

0 -9   None, mod 10 Even number
of digits

Printer adds leading zero, if 
needed, to make the length even

0 -9   None
11, 13 or 16
digits

Length varies because of  
optional 2 or 5 digit supplemental

0 -9   None 6, 8 or 11
digits

Length varies because of  
optional 2 or 5 digit supplemental

128 ASCII
Character Set

None < 32 
characters

See Appendix D

0 -9   None, mod 10,
mod 11

< 16 
characters

Mode 11 checksum cannot
equal 10

All ASCII
characters

0 to 400 levels
of security

< 700
characters None

BARCODE Menu
_ Code  _Text  _Resolution         

BARCODE Menu
_ None  _codaBar _Code39  _Ean8 _eAn13 _I2of5       

BARCODE Menu
_Upca  _uPce _coDe128  _Msiplessey _pdF417       
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Select Code to change the type of bar code you want to print. The printer dis-
plays the types of bar codes available. Use the left and right cursor keys to
move to the left of the option you want and press Enter. If an asterisk displays
to the left of the option, selecting it turns code off.

Depending on the bar code you have selected, some bar codes allow you to
choose whether to include a checksum and change the resolution at which the
bar code is printed as well as whether to print text or the checksum.

Select Text to print text as part of the bar code. Use the left and right cursor
keys to move to the left of the option you want and press Enter. If an asterisk
displays to the left of the option, selecting it turns text printing off. Text is printed
in the following manner:

• Code 39, Code 128, Interleaved 2 of 5 and MSI Plessey: text is printed 
immediately beneath the symbol.

• EAN8, EAN13 and UPC: text for the number system is printed at the left 
of the symbol; text for the product and manufacturer code is printed 
beneath the symbol; text for the supplemental is drawn above 
the symbol.

• PDF 417 has no text option.

Resolution specifies whether you want to print the bar code at normal or high
resolution. Use the left and right cursor keys to select the option you want and
press Enter.

CheckSum specifies the type of error checking you want to use. The type of
bar code selected at Code determines the prompt that displays next. For 
example, if you selected 12 of 5, the following prompt displays:

Some bar code symbologies allow you to print the checksum value as part of
the bar code

Resolution Menu
_ Medium  _High       *

BARCODE CheckSum
_ Mod10  _Mod16       *
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To select the File Menu press the File key. Use the File Menu to create new
files, open files, save files and delete files.

Select New to create a new document. The printer clears any text displayed on
the screen, returns all attributes to factory defaults and displays a blank edit 
screen so you can enter new text. To create a New file, press the File key and
select New with the Enter key. Or use Shift and File as a shortcut.

Select Open to access an existing document you want to edit or print.  The
printer displays a list of file(s) you have saved (see the following example) and
waits for you to select the file you want to work with. Press the File key and use
the cursors to scroll to the left of Open and press Enter. The Open File Menu
is now displayed. Use the left and right cursor keys to scroll to the left of the file
want to open and press Enter to select it. See example below.

Select Save to save the current document. You must save the label you are
working on before you select either New or Open. If you do not save first, it will
be lost. Press the File key and use the cursors to scroll to the left of Save and
press Enter. The Save File Menu is now displayed prompts you to enter a file
name.. 

File names can be any combination of letters and numbers, 8 character maxi-
mum, with no punctuation or file name extensions.

File Menu
_New_Open_Save_Delete

1:_
2:

_ Address _Job 4048 _ww
Open File Menu

Save File Menu
_        



If you enter a file name for an already existing file, you will see the following
message:

Press Y to overwrite or N to enter a different file name. If you decide not to save
the file, simply press Delete.

Select Delete to delete files that you no longer need. Press the File key and
use the cursors to scroll to the left of Delete and press Enter. The Delete File
menu displays a list of files you have saved (see the following example) and
waits for you to select the file you want to delete. Use the left and right cursor
keys to move the cursor to the left of the file you want to delete and press Enter
to select it. If you decide not to delete a file, simply press Delete. 

34

Overwrite?
OK? (Y,N)

_ Address _Job 4048 _ww
Delete File
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You can enter multiple labels in a file by using Page Up an Page Down
to access additional pages (labels). In this case, you can think of a file as a sin-
gle document containing one or more pages (labels). Each label can be up to
six lines. 

To start a new page while you are in a file, use the Shift and the Down Cursor
key to move to the next page. A prompt will appear with the page number.

To move back to the preceding page, use Shift and the Up Cursor key. When
you press the Print key, all pages in the file will be printed.

Page 2

1:_
2:
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To select the Time/Date Menu press the Shift and Repeat keys together. Use
the Time/Date Menu to print labels with 

To use the Time/Date functions you must first set the real time clock with
the local time and date. This will lock the time and date into memory. This will
have to be done once with the exception of summer and winter time changes.

Select Set Clock to enter the current time and date in the printer. Use the cur-
sor keys to scroll to the left of Set Clock and press Enter. The prompt below
will appear. Use the Up and Down cursor keys to scroll through the menu.

The information will be entered in the order shown here:

Year_
Month_
Day_
Hour_ 
Minute_
Second_

Set Clock Parameters

Time/Date Menu
_ Time _datE _stamP _setclOck _24Hourmode       

Prompt Parameters  

Year Last two digits of the year

Month Number from 1 to 12

Day Number from 1 to 31

Hour* Number from 0 to 23 

Minute Number from 0 to 59

Second Number from 0 to 59

* Hour is entered in 24 hour mode (i.e. 1PM would be entered as 13)
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Select Time to add the current time to your label. Use the cursor keys to scroll
to the left of Time and press Enter. The time will be added to the label where
the cursor is positioned. The time can be formatted or deleted just as you had
physically typed it in.

Select Date to add the current date to your label. Use the cursor keys to scroll
to the left of Date and press Enter. The Date Menu will appear offering 6 for-
mats (mm/dd/yy, dd/mm/yy, mm/dd//yyyy, dd/mm/yyyy, dd.mm.yy, dd.mm.yyyy).
Use the cursor keys to scroll to the left of the format you want and press Enter.

The current date will be added to the label where the cursor is positioned. The
date can be formatted or deleted just as you had physically typed it in.

Note: Do not confuse the TIme and Date options with the Stamp option. Time
and Date enters the current time/date into your label at the insertion point, once 
entered they are now considered text by the printer (as if you typed them by
hand). The Stamp function will always use the current time clock at the
time of print job.

Select Stamp to have the current date and time (at the time of print) printed 
vertically on the very edge of the label. Every time you press print a stamp with
the current date and time will be printed in ddhhmmMMMyy format. Use the cur-
sor keys to scroll to the left of Stamp and press Enter. This will turn Stamp on
and an asterisk will be displayed. To turn it off, press Enter again.

Note: Using the stamp on tape supply sizes

0.50” and smaller is not recommended.

Select 24 Hour Mode causes time entered in the text of a label via the Time
option to be in 24 hour mode (i.e., 1 PM as 13). Use the cursor keys to scroll to
the left of 24 Hour Mode and press Enter. This will turn 24 Hour Mode on and
an asterisk will be displayed. To turn it off, press Enter again.

1:03:48:33PM_
2:

 _ mm/dd/yy _dd/mm/yy _
Date Menu

1: 02/01/04 _
2:

File Backup -
Marketing

16
12

-0
1F

eb
04
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The K5100 will operate either standalone or as a PC printer. This new printer
will operate with Microsoft Windows 98, ME, 2000 or XP. Any standard windows
application such as Word, Excel or other programs can print to the K5100 via a
standard Windows printer driver. 

Kroy also includes the Kroy Label Designer Software (KLDS) application with
your printer that contains easy to use, preformatted templates for your printer.

The communications between your printer and your PC are controlled by a win-
dows printer device driver. 

The printer device drivers are located on the included software CD-ROM or cur-
rent drivers are available at www.kroy.com



KLDS Software and Driver Installation
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Installing the KLDS Software
Close all programs prior to installation. Insert the Kroy Label Designer into the
CD-ROM drive. On most systems the installation program will automatically
start. See the steps below to help you along with your setup.

1. The InstallShield Wizard will appear and prepare to install.
2. Kroy Label Designer Setup will appear. Click Next to continue installation.
3. The License Agreement will appear: Click Yes.
4. Choose the Destination: the default will be C:\Program\Kroy Click Next.
5. You will then choose the Setup Type. The default is Typical and is

recommended for most users. Click Next.
6. Click Finish to complete.

Installing the Printer Drivers
The drivers for the KLDS will automatically setup. You will see the following
prompts once the software portion is complete.

1. Do you wish to install Kroy Printers. Click Yes.
2. The Kroy Printer Driver Setup will then appear. Click Next to continue.
3. You can now select to add your Kroy Label Printer under Setup Type.

Click Next to continue.
4. Select the mode of printer installation. Choose Automatic and connect the

printer to your PC using the serial cable. Turn the printer on.
5. Setup will then scan the COM ports on your system for the new printer,

Click Next.
6. Name your Kroy Printer and select it as your default label printer by 

selecting Yes. Click Next.
7. Recommended Port Setting will appear and click OK.
8. Click Finish to complete.
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KLDS Operation

Creating a Label
Double click the KLDS Icon or go to your Start Menu\Programs\Kroy Label
Designer and select it. The main screen will appear.

1. Go to the Label Menu and select Label Setup. Click on the K5100 printer.
Click OK to verify.

2. Select the appropriate Supply Type, Size and Label Orientation that you 
are using in your K5100.
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3. A label template will appear on the Main Menu Screen. Select the Text 
Tool “A” from the Main Tool Bar, click your left mouse button on the label 
template and input text at the blinking cursor.

4. After creating your label, click on the Print Icon from the top tool bar, or go
to the Label Menu and select Print. Select the number of copies and click 
OK to print your label.

5. The K5100 will then print your label.

For further assistance, go to the Help Menu of your KLDS Software.
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Downloading Fonts

Downloading a Font
The K5100 has the option of downloading fonts from the PC into your Font
Menu. Follow the steps below.

1. Connect the serial cable to the com port of choice and to your printer.
2. Go to the Start Menu of your PC and go to Settings and select Printers.
3. Right click on the K5100 driver and go to Properties.

4. Click on Control and go to Advance Options...

5. Select Download Fonts from the Menu and click Update.



44

6. Go to the Font folder on the C drive of your PC and click OK.

7. Select the Font or Font Family of your choice and click OK.

8. The LCD Display of the printer will show the progress of the download using 
the pound sign(#) across the bottom. The printer will show a receiving and an
updating display.

9. The download is now complete and you can find the font in your Font Menu.
Press the Delete key to accept the current Block font or use the left and right
cursor keys to move the cursor to the left of the font you want and press 
Enter to select it.

Receiving...
#####

Updating...
#####

 _ Block _times _arial
Font Menu
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Using Your Printer with Other PC Applications

You may also use other Windows applications to create labels with the K5100
printer. This is an example using Microsoft Word to create a label.

1. Click on the File menu and select Print.

2. Select the Kroy K5100 Label Printer in the drop down box and Click Close.
3. Click on the File Menu and select Page Setup.

4. Click on the Paper Size tab and select the supply type. This size should 
match the size of the width on the supply cartridge currently installed in your 
K5100 printer. Usually you will want Landscape orientation selected.



5. Select the Margins tab and change the top, bottom, left, right, gutter, header 
and footer to “0” or desired margin values.  The default margins must be 
changed since you are not printing to a full 8.5” x 11” page. For some media, 
Word will want to “Fix” the margins based on the maximum printable area of 
the media selected. In this case, 1” tape requires a 0.05” top and bottom 
margin. Click on OK.

6. It is recommended to click on the View menu and select Page Layout mode.
7. A blank label template with a blinking cursor will appear on your PC monitor.
8. Enter the label text.

9. Select Print from the File menu. Make sure that the K5100 is selected and 
Click OK to print the label. Note: When printing and the cartridge runs out of 
tape, remove and install a new cartridge, and press Feed to continue printing.
DO NOT TURN OFF THE PRINTER.

To Save your label, go to the File menu and select Save. You can also save the
document as a template to start other label files.

46
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Appendix A: Maintaining Your Printer

The printer requires no lubrication and only minimal maintenance. Occasional
cleaning of the exterior surfaces and regular cleaning of the printhead and
rollers are all that is required. This appendix explains how to clean these parts
of your printer.

Cleaning the Printhead and Rollers
The printhead and rollers should be cleaned after every cartridge  Use isopropyl
90% alcohol on a soft cotton swab to remove adhesive buildup and tape and
ribbon residue. Make sure the alcohol has evaporated before loading a supply
cartridge.

Note: Avoid touching the surface of the printhead with your finger. Acids and oils
on your skin will damage the printhead.



B-1

Appendix B: System Messages

The following are system messages that the K5100 will display and an explana-
tion of each message.

Cannot Save (1) There is not enough memory to save your file.
No Memory Either delete unneeded files or simplify labels by 

reducing the amount of text or the number of 
formatting options they contain. (2) You tried to save
a file to drive B when it is write protected.

Cartridge Empty Cartridge supply is empty. Install a new cartridge.

Font Size Too Big The point size is too large for the number of lines 
you have entered. Reduce the point size or select
fewer lines.

Size Too Small Auto size has calculated a size smaller than the minimum 
size of 4 pt.

Font Error! You entered the wrong number of characters for the 
bar code. Check the requirements for the type of bar code
you are using and enter the correct number of characters.

No Cartridge Install a cartridge in order to print.

No Files Found You selected Open or Delete but have no files 
saved in memory. You must save files before you 
can open or delete them.

Printer Too Hot The printer is too hot to print labels. Wait about five
minutes and then resume printing. This message 
may also appear when the printer is used in an 
ambient temperature below its minimum rated 
operating temperature.

Printing... The printer is printing labels. No action required.
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Appendix C: Troubleshooting

This appendix explains how to solve some common problems that may
arise when you are using the printer. If you are unable to correct the problem
contact  your Dealer or Kroy Customer Service. In the United States, call
(800)347-5769; in Europe call +44-(0)118-986-5200.

Display stays black/blank • Adjust the LCD Contrast 
after printer is turned on • Make sure the AC Adapter is firmly 

connected or the optional batteries
are fully charged

Printer does not print • Ensure the lock/release knob is in the 
locked position

• Check the supply cartridge and its position
• Check that the AC adapter and/or serial 

cable is firmly connected

Printed characters are not • Adjust the print density
formed properly • Clean the printhead and rollers

Printed characters have a • Turn off printer and use a Kroy Cleaning
line through them and/or Kit (Part#255900) or use 90% or better 
voids isopropyl alcohol on a cotton swab to 

clean the printhead and rollers (See 
Appendix A) for instructions.

Printer isn't working • Reset the printer
properly • Turn the printer on and off

Printer has locked up • Turn the printer on and off
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Appendix D: Updating Firmware

Updating Firmware
Updates for firmware can be found at www.kroy.com. Go to support and click on
downloads. 

1. Connect the serial cable to your Com port of choice and to your printer.
2. Download the updated file from our site.
3. Save the file to your PC.
4. Go to your Start Menu of your PC and go to Settings and select Printers.
5. Right click on the K5100 driver and go to Properties.

6. Click on Control and go to Advance Options...

7. Select Download Firmware from the menu and click Update.

8. A warning will appear below and click Yes to continue.
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9. Select the firmware file and click Open.

10. The printer will then update the file.

The LCD Display will show the progress of the download using the pound 
sign(#) across the bottom. The printer will show a receiving and an updating
display.

9. The download is now complete.

Receiving...
#####

Updating...
#####
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Appendix E: Using Accent Characters

K5100 has a variety of international characters and symbols found in Blue on
the keypad. Use the Alt key + the accent character and/or symbol to print out
these special accent characters. 

In our example, we will use the ´ accent character and add it to the letter “i”
in “Factoría” (Factory).

The “i” in “Factoría” must be accented. To do this, you will hold down the Alt +
key on the keypad. This activates the accent character. You will then press

the letter “I” on the keypad. The printer will then display the accented character
in the text of the label.

Accent Character Guide

_1:Factoría
2:

aAeEiIoOuU
aAnNoO
aAeEiIoOuUyY
aAeEiIoOuU
aAeEiIoOuUyY

^
~

¨
`
´
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Appendix F: Using the Character Map 

The K5100 has the capability to accept code to print characters not found on
the keyboard. To use the character map, the Extended Mode must be on.To
turn the Extended Mode on press the Alt and Space key together. To turn this
mode off, press the Alt and Space key together again. See the character set
below for ASCII codes to assist you.

To enter characters in extended mode, enter the 4 digit code shown in the table
below. Most of the characters will be properly displayed on the LCD. For some
characters, a solid block place holder will display on the LCD, but the selected
character will print on the label.

ASCII Code  Character

0123 {
0124 |
0125 }
0126 ~
0140 Œ
0156 œ
0159 Ÿ
0162 ¢
0163 £
0165 ¥
0168 ¨
0176 °
0177 ±
0180 ´
0191 ¿
0192 À
0193 Á
0194 Â
0195 Ã
0196 Ä
0197 Å
0198 Æ
0199 Ç
0200 È
0201 É
0202 Ê
0203 Ë

ASCII Code  Character

0204 Ì
0205 Í
0206 Î
0207 Ï
0208 Ð
0209 Ñ
0210 Ò
0211 Ó
0212 Ô
0213 Õ

0214 Ö
0215 ×
0216 Ø
0217 Ù
0218 Ú
0219 Û
0220 Ü
0221 Ý
0222 Þ
0223 ß
0224 à
0225 á
0226 â
0227 ã
0228 ä
0229 å
0230 æ

ASCII Code  Character

0231 ç
0232 è
0233 é
0234 ê
0235 ë
0236 ì
0237 í
0238 î
0239 ï
0240 ð
0241 ñ
0242 ò
0243 ó
0244 ô
0245 õ
0246 ö
0247 ÷
0248 ø
0249 ù
0250 ú
0251 û
0252 ü
0253 ý
0254 þ
0255 ÿ
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